Lesa Snider, an internationally acclaimed author and speaker, is on a mission to teach the world to create better imagery. She’s the author of Photoshop CC: The Missing Manual, The Skinny series of ebooks, and over 40 video courses on topics such as image editing, graphic design, and stock photography. Lesa is a regular columnist for Macworld, Photoshop User, and Photo Elements Techniques magazines.

Answers found here!
Apple’s new Photos app lets you do a whole lot more than simply store and edit pictures and videos on a Mac or iOS device. With this comprehensive guide, you’ll learn how to import, organize, and share your digital memories, as well as how to improve, print, and use your photos in creative projects. With Lesa Snider’s step-by-step instructions and expert advice, you’ll master Photos and tame your image library—and have fun along the way!

The important stuff you need to know

- **Migrate from iPhoto.** Learn how to make a quick and smooth transition.
- **Organize your collection with ease.** Master the many ways to import, group, and categorize images—and set up iCloud Family Sharing.
- **Sharpen your editing skills.** Skillfully use Photos’ impressive image- and video-editing tools on your Mac or iOS device.
- **Access photos anywhere.** Sync your library to all of your Apple devices so your photos travel with you wherever you go.
- **Share them online.** Show your shots to everyone on your list by using shared albums, creating web galleries, posting them on Facebook, and more.
- **Dive into creative projects.** Build pro-level slideshows to share with others, and create gorgeous gift books, calendars, and cards.

Photos for Mac and iOS

Macintosh/Digital Photography

US $29.99  CAN $34.99

missingmanuals.com
Answers found here!

Apple’s new Photos app lets you do a whole lot more than simply store and edit pictures and videos on a Mac or iOS device. With this comprehensive guide, you’ll learn how to import, organize, and share your digital memories, as well as how to improve, print, and use your photos in creative projects. With Lesa Snider’s step-by-step instructions and expert advice, you’ll master Photos and tame your image library—and have fun along the way!

The important stuff you need to know

- **Migrate from iPhoto.** Learn how to make a quick and smooth transition.
- **Organize your collection with ease.** Master the many ways to import, group, and categorize images—and set up iCloud Family Sharing.
- **Sharpen your editing skills.** Skillfully use Photos’ impressive image- and video-editing tools on your Mac or iOS device.
- **Access photos anywhere.** Sync your library to all of your Apple devices so your photos travel with you wherever you go.
- **Share them online.** Show your shots to everyone on your list by using shared albums, creating web galleries, posting them on Facebook, and more.
- **Dive into creative projects.** Build pro-level slideshows to share with others, and create gorgeous gift books, calendars, and cards.

“Answers found here!”

Apple’s new Photos app lets you do a whole lot more than simply store and edit pictures and videos on a Mac or iOS device. With this comprehensive guide, you’ll learn how to import, organize, and share your digital memories, as well as how to improve, print, and use your photos in creative projects. With Lesa Snider’s step-by-step instructions and expert advice, you’ll master Photos and tame your image library—and have fun along the way!

The important stuff you need to know

- **Migrate from iPhoto.** Learn how to make a quick and smooth transition.
- **Organize your collection with ease.** Master the many ways to import, group, and categorize images—and set up iCloud Family Sharing.
- **Sharpen your editing skills.** Skillfully use Photos’ impressive image- and video-editing tools on your Mac or iOS device.
- **Access photos anywhere.** Sync your library to all of your Apple devices so your photos travel with you wherever you go.
- **Share them online.** Show your shots to everyone on your list by using shared albums, creating web galleries, posting them on Facebook, and more.
- **Dive into creative projects.** Build pro-level slideshows to share with others, and create gorgeous gift books, calendars, and cards.

“Answers found here!”

Apple’s new Photos app lets you do a whole lot more than simply store and edit pictures and videos on a Mac or iOS device. With this comprehensive guide, you’ll learn how to import, organize, and share your digital memories, as well as how to improve, print, and use your photos in creative projects. With Lesa Snider’s step-by-step instructions and expert advice, you’ll master Photos and tame your image library—and have fun along the way!

The important stuff you need to know

- **Migrate from iPhoto.** Learn how to make a quick and smooth transition.
- **Organize your collection with ease.** Master the many ways to import, group, and categorize images—and set up iCloud Family Sharing.
- **Sharpen your editing skills.** Skillfully use Photos’ impressive image- and video-editing tools on your Mac or iOS device.
- **Access photos anywhere.** Sync your library to all of your Apple devices so your photos travel with you wherever you go.
- **Share them online.** Show your shots to everyone on your list by using shared albums, creating web galleries, posting them on Facebook, and more.
- **Dive into creative projects.** Build pro-level slideshows to share with others, and create gorgeous gift books, calendars, and cards.

“Answers found here!”

Apple’s new Photos app lets you do a whole lot more than simply store and edit pictures and videos on a Mac or iOS device. With this comprehensive guide, you’ll learn how to import, organize, and share your digital memories, as well as how to improve, print, and use your photos in creative projects. With Lesa Snider’s step-by-step instructions and expert advice, you’ll master Photos and tame your image library—and have fun along the way!

The important stuff you need to know

- **Migrate from iPhoto.** Learn how to make a quick and smooth transition.
- **Organize your collection with ease.** Master the many ways to import, group, and categorize images—and set up iCloud Family Sharing.
- **Sharpen your editing skills.** Skillfully use Photos’ impressive image- and video-editing tools on your Mac or iOS device.
- **Access photos anywhere.** Sync your library to all of your Apple devices so your photos travel with you wherever you go.
- **Share them online.** Show your shots to everyone on your list by using shared albums, creating web galleries, posting them on Facebook, and more.
- **Dive into creative projects.** Build pro-level slideshows to share with others, and create gorgeous gift books, calendars, and cards.

“Answers found here!”

Apple’s new Photos app lets you do a whole lot more than simply store and edit pictures and videos on a Mac or iOS device. With this comprehensive guide, you’ll learn how to import, organize, and share your digital memories, as well as how to improve, print, and use your photos in creative projects. With Lesa Snider’s step-by-step instructions and expert advice, you’ll master Photos and tame your image library—and have fun along the way!

The important stuff you need to know

- **Migrate from iPhoto.** Learn how to make a quick and smooth transition.
- **Organize your collection with ease.** Master the many ways to import, group, and categorize images—and set up iCloud Family Sharing.
- **Sharpen your editing skills.** Skillfully use Photos’ impressive image- and video-editing tools on your Mac or iOS device.
- **Access photos anywhere.** Sync your library to all of your Apple devices so your photos travel with you wherever you go.
- **Share them online.** Show your shots to everyone on your list by using shared albums, creating web galleries, posting them on Facebook, and more.
- **Dive into creative projects.** Build pro-level slideshows to share with others, and create gorgeous gift books, calendars, and cards.

“Answers found here!”

Apple’s new Photos app lets you do a whole lot more than simply store and edit pictures and videos on a Mac or iOS device. With this comprehensive guide, you’ll learn how to import, organize, and share your digital memories, as well as how to improve, print, and use your photos in creative projects. With Lesa Snider’s step-by-step instructions and expert advice, you’ll master Photos and tame your image library—and have fun along the way!

The important stuff you need to know

- **Migrate from iPhoto.** Learn how to make a quick and smooth transition.
- **Organize your collection with ease.** Master the many ways to import, group, and categorize images—and set up iCloud Family Sharing.
- **Sharpen your editing skills.** Skillfully use Photos’ impressive image- and video-editing tools on your Mac or iOS device.
- **Access photos anywhere.** Sync your library to all of your Apple devices so your photos travel with you wherever you go.
- **Share them online.** Show your shots to everyone on your list by using shared albums, creating web galleries, posting them on Facebook, and more.
- **Dive into creative projects.** Build pro-level slideshows to share with others, and create gorgeous gift books, calendars, and cards.

“Answers found here!”

Apple’s new Photos app lets you do a whole lot more than simply store and edit pictures and videos on a Mac or iOS device. With this comprehensive guide, you’ll learn how to import, organize, and share your digital memories, as well as how to improve, print, and use your photos in creative projects. With Lesa Snider’s step-by-step instructions and expert advice, you’ll master Photos and tame your image library—and have fun along the way!

The important stuff you need to know

- **Migrate from iPhoto.** Learn how to make a quick and smooth transition.
- **Organize your collection with ease.** Master the many ways to import, group, and categorize images—and set up iCloud Family Sharing.
- **Sharpen your editing skills.** Skillfully use Photos’ impressive image- and video-editing tools on your Mac or iOS device.
- **Access photos anywhere.** Sync your library to all of your Apple devices so your photos travel with you wherever you go.
- **Share them online.** Show your shots to everyone on your list by using shared albums, creating web galleries, posting them on Facebook, and more.
- **Dive into creative projects.** Build pro-level slideshows to share with others, and create gorgeous gift books, calendars, and cards.
Want to read more?

You can buy this book at oreilly.com in print and ebook format.

Buy 2 books, get the 3rd FREE!
Use discount code OPC10
All orders over $29.95 qualify for free shipping within the US.

It’s also available at your favorite book retailer, including the iBookstore, the Android Marketplace, and Amazon.com.
Contents

Foreword ................................................................. ix

The Missing Credits .................................................. xiii

Introduction ............................................................. xv
Photos' Backstory......................................................... xvi
What Photos Can Do ..................................................... xvii
Using Photos for iOS .................................................... xviii
About These Arrows ...................................................... xx
About the Online Resources ........................................ xxii
The Very Basics ........................................................... xxi
Safari Books Online ..................................................... xxiii

CHAPTER 1: Getting Started with Photos ......................... 1
Getting the Photos App .................................................. 1
Your First Foray into Photos .......................................... 2
Migrating from iPhoto or Aperture to Photos .................... 4
iPhoto and Aperture Edits Become Permanent ................. 7
How Photos Handles Albums, Events, Projects, and Metadata ............ 7
Continuing to Use iPhoto or Aperture ............................ 8
Merging iPhoto or Aperture Libraries ............................. 9
Deleting iPhoto or Aperture Libraries ........................... 10
Meet the iCloud Photo Library ..................................... 11
What Gets Uploaded ...................................................... 13
Photos for Families ....................................................... 14

CHAPTER 2: Importing Pictures and Videos .................. 17
The Two Faces of Photos ................................................ 17
Importing from iCloud .................................................. 19
iCloud Photo Library .................................................. 19
iCloud Photo Sharing .................................................. 22
My Photo Stream ......................................................... 23
Importing from a Camera or Card Reader ...................... 24
Importing Other Image Files .......................................... 27
Copied vs. Referenced photos ..................................... 28
Importing Files from Other Apps ................................. 30
Importing images from Apps that Don't Share ............... 32
Importing Videos .......................................................... 33
Fun with File Formats .................................................. 34
  Raw Files .................................................................. 34
  Other File Formats .................................................. 34
After the Import .......................................................... 35
Dealing With Duplicates .............................................. 38
Visiting Your Photos Library ........................................ 38

CHAPTER 3: Viewing and Organizing Your Images .................. 41
Photos’ Views ............................................................ 42
  Photos View .......................................................... 43
  Shared View ......................................................... 46
  Albums View ......................................................... 47
  Projects View ........................................................ 50
Viewing, Opening, and Scrolling ...................................... 51
  Resizing Thumbnails ................................................ 51
  Opening Files ....................................................... 52
  Using Split View (Mac only) ..................................... 52
  Scrolling Through Thumbnails .................................. 52
  Viewing Metadata .................................................. 54
  Using Summarize View ............................................ 56
Selecting and Hiding Files ............................................ 56
  Hiding Thumbnails .................................................. 59
The Wide World of Albums ............................................ 60
  Creating an Album .................................................. 60
  Adding files to an Album ......................................... 62
  Viewing an Album .................................................. 63
  Changing an Album’s Key Photo (Mac only) ............... 63
  Renaming an Album ................................................ 64
  Moving Files Between Albums .................................. 64
  Removing Files from an Album .................................. 65
  Duplicating Files .................................................... 66
  Sorting Thumbnails in Albums .................................. 67
  Sorting Album Thumbnails ....................................... 67
  Duplicating an Album ............................................. 67
  Merging Albums ..................................................... 68
  Deleting an Album .................................................. 68
  Smart Albums ........................................................ 69
Using Folders ............................................................ 73
  Adding and Removing Items from Folders .................. 73
The Mighty Info Panel .................................................. 74
Deleting Pictures and Videos ........................................ 75
  Viewing or Recovering Recently Deleted Items ............ 77
Accessing Your Photos Library on the Web ....................... 78
CHAPTER 7: Printing Your Photos ........................................................................... 183
  Printing at Home ............................................................................................ 184
  Resolution Matters ........................................................................................ 184
  Printing from Photos ...................................................................................... 188
  Ordering Prints Online ................................................................................... 193
  Buying Prints from Apple ............................................................................... 193

CHAPTER 8: Sharing and Exporting ........................................................................ 201
  Sharing via Email ............................................................................................ 202
  Emailing Photos from an iOS Device ............................................................. 205
  Sharing via Text Message ................................................................................ 206
  Sharing Online ................................................................................................. 207
  Twitter ............................................................................................................. 207
  Facebook ......................................................................................................... 208
  Flickr ............................................................................................................... 209
  Using iCloud Photo Sharing .......................................................................... 211
  Turning on iCloud Photo Sharing .................................................................. 212
  Creating a Shared Album ................................................................................ 213
  Adding Content to a Shared Album ............................................................... 215
  Deleting and Unsubscribing from a Shared Album ....................................... 216
  Letting Subscribers Add to a Shared Album ................................................ 216
  Managing Subscribers ................................................................................... 218
  Publishing a Shared Album on the Web ....................................................... 220
  Downloading Shared Content ...................................................................... 222
  Adding and Viewing Comments ................................................................... 222
  Family Sharing ................................................................................................ 224
  Sharing via AirDrop ........................................................................................ 227
  Desktops, Lock Screens, and Wallpaper ....................................................... 228
  Setting a Photo as Your Desktop (Mac) ....................................................... 229
  Setting a Photo as Your Wallpaper (iOS) .................................................... 229
  Photos: The Best Screensaver in the West .................................................... 229
  Exporting from Photos ................................................................................... 231
  Exporting by Dragging .................................................................................... 232
  The Mighty Export Command ...................................................................... 232
CHAPTER 9: Creating Custom Books, Calendars, and Cards ........... 237
  Creating a Book Project ............................................. 238
    Step 1: Selecting Images ........................................... 238
    Step 2: Choosing a Format and Theme .......................... 239
    Step 3: Customizing the Pages .................................. 242
    Step 4: Edit and Format Text ..................................... 254
    Step 5: Preview Your Project ...................................... 257
    Step 6: Buy the Book ............................................... 259
  Photo Calendars ......................................................... 260
    Step 1: Pick the Pictures ........................................... 261
    Step 2: Choose the Length, Start Date, and Theme .......... 261
    Step 3: Customize the Pages ...................................... 263
    Step 4: Final Inspection ........................................... 266
    Step 5: Buy the Calendar .......................................... 266
  Custom Cards ........................................................... 266

CHAPTER 10: Managing Your Library ................................ 271
  Using Multiple Libraries ............................................. 272
    Creating a New Library ............................................ 273
    Switching Between Libraries .................................... 274
    Changing the System Photo Library ............................. 274
    Merging Libraries .................................................. 275
  Backing Up Your Files ............................................... 277
    Backing Up to a Hard Drive ...................................... 278
    Backing Up to CDs and DVDs ..................................... 281

APPENDIX A: Troubleshooting .......................................... 287
  The Big Takeaway .................................................... 287
  Upgrading and Importing .......................................... 288
  Organizing Troubles ................................................ 292
  Sharing and Syncing ............................................... 294
  Editing Woes .......................................................... 297
  Printing Problems ................................................... 297
  General Questions ................................................... 298

Index ................................................................. 301
Photos, as you probably already know, is a program that you can use to store and edit your digital images and videos. But that just scratches the surface of what it can do. Perhaps most remarkably, Photos can keep your image library backed up and synchronized across all your Apple devices. That way your Mac, iPad, iPhone, and iPod Touch all contain the same photos, videos, and albums, all the time, which is pretty darn amazing. And by using Photos’ shared albums, your family and friends can share photos from events as they’re happening, and you can view them in a self-updating album on any device. Because your photos and videos are always available on all your devices, you can use Photos’ incredibly powerful editing tools anywhere—for example, you could start editing on your iPhone, continue on your Mac, and then finish on your iPad.

NOTE

Technically speaking, Photos is a database—a special kind of program that tracks all the files you tell it about. Databases perform their tracking magic by creating a support file—a library, in this case—that includes an individual record for each file you import. If that’s clear as mud, consider another app that you (likely) interact with all the time: the Contacts app on your Mac or iOS device. The Contacts app is a database that points to a file containing an individual record for each person you’ve told it about. A physical and somewhat vintage analogy is a Rolodex (database) and all the little cards (records) it contains.

Photos lets you view all kinds of info about each image file, including the camera settings you used when you took the shot (great for improving your photographic skills), as well as the date, time, and location (if your camera has that ability). You can add your own info to each file, too, such as who’s in the picture, custom titles, and descriptive phrases that can help you find certain pictures more easily. Even the edits you perform in Photos get tucked into each file's record, so you can undo
the edits whenever you want. And Photos isn’t just for managing images and videos taken on digital cameras; it can easily manage pictures you’ve scanned or had burned onto disc by your local camera store.

But Photos goes far beyond all that. For instance, once you identify a few faces in your photo library (you’ll learn how in Chapter 4), the program begins finding and identifying them all on its own, so you can spend more time building creative projects—slideshows, books, calendars, cards—and less time digging through your library to find specific images. Photos helps you organize your digital memory collection in other ways, too. For example, it displays your images in chronological order and automatically creates albums that help you find certain files, such as the last ones you imported, ones you’ve marked as favorites (page 82), or videos. You can create your own albums, too, and then combine them into projects, convert and export them for use elsewhere, and easily share them with friends and family.

By embracing Photos, you’re getting in on the ground floor of something very special: the first complete photo and video organizer for a mobile lifestyle—whether mobile for you means moving from the living room to the bedroom or jetting across the globe. This book is your trusty guide to this amazing new program.

NOTE In the past, the word “program” was used for software that ran on desktop and laptop computers, and the word “app” was to describe software that ran on iOS devices (the iPhone, iPad, and iPod Touch). These days, Apple uses the word “app” to describe all kinds of software, regardless of the device it runs on. This book uses both terms, but leans toward “app.” Don’t be confused—when you see the term “app” or “program,” it just means “software.”

## Photos’ Backstory

Apple knows there are precious few people who enjoy the time-consuming task of managing and processing photos, so they’ve tried to make it as painless as possible. Back in 2002, Apple introduced iPhoto, Photos’ predecessor, which enjoyed a long reign as the simplest image-organizing and -editing program available for the Mac. iPhoto introduced millions of people to the joys of image editing, and offered the more adventurous quite a lot of editing power and flexibility. The only problem with iPhoto enjoying such a long life is that it had a lot of outdated code under its hood, resulting in a program that crashed often and, if you had a big photo library, ran as slow as molasses. Therefore, in the summer of 2014, Apple announced that it would stop updating iPhoto and its pro-level sibling, Aperture, in favor of a fresh start with a new program: Photos.

NOTE Just because Apple will no longer update iPhoto and Aperture doesn’t mean you have to stop using them. As of this writing, both programs perform perfectly well in Yosemite 10.10.3, right alongside Photos.
Photos is a completely redesigned image organizer and editor that can do (nearly) everything iPhoto could, plus a whole lot more. Built especially for OS X Yosemite, Photos is smokin’ fast and has a wonderfully sleek design. Compared to iPhoto, it offers a more logical way of viewing your pictures based on date (instead of events), and easier ways of getting around within the program. Also, Photos’ editing tools are more powerful than iPhoto’s, and the program inherited many editing features that were found only in Aperture. You get a slew of fun filters for applying nifty color and film-grain effects, plus a simpler process of creating books, cards, slideshows, calendars, and prints. And, as in iPhoto, everything you do in Photos is 100% non-destructive, meaning you can undo your edits anytime you want.

Perhaps the most exciting news is that you can use Photos in conjunction with Apple’s iCloud storage service to sync your picture library to all your Apple devices, so you can have all your photos with you all the time. That’s right: You can avoid the sinking feeling you get when you want to show a photo to someone, but you can’t remember where the heck that picture lives. Alas, this syncing service isn’t free, but it’s affordable—and the peace of mind you get from knowing your files are backed up is worth the small fee. But you don’t have to use it.

Like iPhoto, Photos is built to handle the needs of the masses—it’s not designed for professional photographers. So if you need the ability to edit certain parts of a photo, fix perspective or lens-distortion problems, and the like, then you need a pro-level image organizer and editor such as Adobe Photoshop Lightroom.

**TIP** If you want to remove your ex from a vacation picture, combine images, push photos through text, or draw and paint from scratch, you need the advanced editing power found in programs such as Pixelmator, Adobe Photoshop Elements, or the 10-ton gorilla of photo editing, Photoshop. Conveniently, your humble author has written a book about it: [*Photoshop CC: The Missing Manual*](https://www.missingmanuals.com), available from [www.missingmanuals.com](https://www.missingmanuals.com). (For other books and videos by your author, visit [www.PhotoLesa.com](https://www.PhotoLesa.com).)

## What Photos Can Do

As mentioned earlier, Photos can do most everything that iPhoto could, save for the exceptions mentioned in the box on page xx. If you’re a seasoned iPhoto user or you’ve used the Photos app on your iOS device (iPhone, iPad, or iPod Touch), then you’ll feel right at home in Photos on your Mac. Here’s a rundown of what you can expect to accomplish with Photos:

- **Import images.** Photos can import pictures and video from just about anywhere, be it a camera or memory card that you plug into your Mac or an iOS device. If you’ve got an iCloud account that you sync pictures with, you can import from there, too. Photos understands almost any image format, including the raw format captured by most cameras (page 34).
• **View your snapshots.** Photos logically organizes your pictures and videos by years, collections, and moments. In Years view, you see teeny-tiny thumbnails of your pictures based on the years they were taken, which you can scroll through at high velocity. To see one of your shots at a larger size, just click and hold its thumbnail. To drill deeper into your photo library, click within any year and you open Collections view, which shows pictures taken at the same place within a certain time period—during a recent trip to New York, say. This view is similar to iPhoto's Events. Click inside a Collection and you open Moments view, which displays pictures taken within a shorter time period—your big night out on Broadway, perhaps. If your camera captures location info (as iOS devices do), you can also view your thumbnails plotted on a map. The program's Info panel shows when you took each photo and what camera settings you used. Photos for Mac lets you maximize your screen real estate, too—its Full Screen view makes your pictures feel practically life-sized.

• **Organize your collection.** You can manually arrange pictures into albums that you create, though Photos includes several built-in albums such as All Photos, Faces, Last Import, Favorites, and Videos. If you're lucky enough to have a newer iOS device that has a camera with the nifty Panorama, Slo-mo, Time-lapse, and Burst features, you automatically get albums for that stuff, too. Photos also has a powerful (and trainable) facial-recognition feature, as well as smart albums, which self-populate based on criteria that you set. You can mark your best pictures with a Favorites tag, making them easier to find later on, and also create and assign keywords, which let you find groups of photos based on similar content (such as flowers, food, or Fido).

• **Find pics quickly.** Photos includes a powerful search field that lets you easily locate photos based on any text associated with them, such as a filename, keyword(s), a face you've named, a description you've added, or where you took them. This field also lets you locate photos taken during a certain time period or on a specific date.

• **Sync and share images.** Apple's iCloud Photo Library lets you sync all your pictures across all your Apple devices, and ensures that full-size versions of everything in your library are safely backed up onto Apple's servers. This service is insanely convenient, though as page 11 explains, you do have to pay for it. You can also use iCloud to create shared albums (which are great for sharing photos with far-flung friends or relatives) and you can easily upload pictures to social media sites such as Facebook, Flickr, and Twitter. Emailing pictures from Photos is a breeze, as is sending them to others via text message. You can also transfer pictures onto other Apple devices using AirDrop.

• **Edit your pictures.** Photos offers editing tools for every skill level. You can use its one-click options to easily enhance, rotate, crop, straighten, and flip your images horizontally or vertically, and to apply a plethora of filters to give your shots creative color treatments. In Adjust mode, you’ll find powerful and innovative preview-based controls for adjusting lighting (exposure, highlights, shadows, brightness, contrast, and so on), and color (saturation, contrast, and
cast), among other things. You can reveal additional controls for things like sharpening, adding definition, reducing noise, and adding an edge vignette. Photos also lets you zap blemishes, scratches, and stray hairs with the Retouch tool, and even conquer pesky red-eye. Once you've corrected one picture, you can easily copy and paste those edits onto another image. And it's super simple to duplicate a photo if you want versions with different effects (say, a full-color version and a black and white).

• **Make slideshows and movies.** You can create instant and saved slideshows using Photos' beautiful built-in themes, which come complete with background music. When you craft a saved slideshow, you can add text to any slide you want (a feature that even iPhoto didn't have). You can also customize elements such as transitions, slide duration, and whether the slideshow loops. Photos also lets you view and edit any movies you've imported—you can trim clips, adjust the timing of slow-motion videos, select a preview frame, and export frames as pictures. And when you're done creating your slideshow or movie masterpiece, you can easily export it to share with others and send it over to iTunes for syncing with your iOS devices.

• **Print your images.** Photos lets you print pictures in a variety of sizes on your own printer or order pro-level prints from Apple. Either way, Photos handles all of the resizing so you don’t have to worry about it. And if you print on your own printer, you can easily gang multiple pictures onto a single page.

• **Create books, calendars, and cards.** Photos includes several themes you can use to create some of the world’s most beautiful photo books, calendars, and greeting cards (of both the folded and postcard variety). The program’s easy-to-use design controls let you make every page of every project look just the way you want. After that, you can upload the whole kit-and-caboodle to Apple so they can professionally print it, and then ship it to you or your lucky recipient.

### Using Photos for iOS

To keep things simple, Apple designed Photos for the Mac to be virtually identical to Photos for iOS (that is, the version for iPhone, iPad, and iPod Touch). In Photos for iOS, you can view, tag, edit, and share your pictures just like you can in Photos for Mac. That said, you need your Mac—and a much bigger screen than any iOS device has—to build projects such as slideshows, books, calendars, and cards, and to order prints.

There are slight differences between the two programs, and they’ll be duly noted in this book when they occur. The most obvious difference is that, rather than clicking things like you do on a Mac, you tap them on your touchscreen. So if you’re reading this book while working with an iOS device, whenever you see the word “click,” think “tap” instead. Also, you get fewer editing tools in Photos for iOS than in Photos for Mac. But for the most part, mastering one version of the program means you’ve also mastered the other, which is convenient.
### About These Arrows

Throughout this book, and throughout the Missing Manual series, you’ll find sentences like this one: “Open your User folder → Pictures → Photos Library.” That’s shorthand for a much longer set of instructions that direct you to open three nested items in sequence. Those instructions might read: “On your hard drive, you’ll find a folder called Casey (or whatever your user folder is named). Open it. Now locate the Pictures folder and open it, too. Inside it you’ll spot a file called “Photos Library.”

---

#### UP TO SPEED

### Photos vs. iPhoto

As with most things Apple-related, the company giveth and it taketh away. While Photos can do most of the things that iPhoto can, it’s missing a few features. Here’s the lowdown on what you can do with iPhoto that you *can’t* do in Photos (as of this writing, anyway):

- **No Events.** Apple replaced events with Collections and Moments views (page 43), which you can use to get a birds-eye, chronological view of images you took around the same time.

- **No star rating system.** Photos doesn’t let you add star ratings, but it does convert any star ratings you added in iPhoto or Aperture into keywords, so all is not lost. In fact, you could use keywords to continue your own star rating–type system, as explained in the box on page 96.

- **No manual geotagging.** Unfortunately, the only way to connect location info to a picture in Photos is for your camera to include it when you snap the shot (though the box on page 90 has a few workarounds). Your iPhone captures location info automatically, and your iPad can do so if it’s on a wireless network or you sprang for a cellular data plan. Most newer, pricier cameras can do this, too. And while there’s no Places map in Photos per se, you can use Collections and Moments views to see a huge map with tiny thumbnails marking the locations where they were taken.

- **No album sorting by keyword, title, or rating.** Bummer!

- **No shared libraries.** If someone else on your wireless network uses Photos, you can’t access their library on your Mac. Heck, you couldn’t do this in the last version of iPhoto, either. The only way to share photos is to set up shared albums using iCloud (page 211), which is mercifully painless. (Page 14 details a tidy and stress-free solution for sharing pictures among family members.)

- **No external editors.** Alas, you can’t send a picture from Photos to another program (such as Photoshop Elements) for additional editing.

- **Limited smart album criteria.** Photos lets you create smart albums that self-populate based on criteria you set, but your criteria options are limited. For example, you can’t create a smart album that tracks down all the photos that you haven’t applied any keywords to.

- **No slideshow captions.** You can still add titles and descriptions to your photos using the program’s Info panel, but you can’t pull that info into slideshows for use as captions. That said, you can add custom text to any slide.

- **Limited fun with AppleScript.** For the more technical folks in the audience, you may be saddened to hear that you can’t use AppleScript to automate as many things in Photos as you could in iPhoto. Also, Photos doesn’t work with scripts you cobble together yourself in Automator.

Will any of these features be introduced in future versions of Photos? Possibly, though there’s no telling if or when. Maybe Apple is just giving the program plenty of room to grow.
Similarly, this kind of arrow shorthand helps to simplify the business of choosing commands in menus. The instruction “Choose File → Export → Export Slideshow” means, “In Photos, open the File menu at the top of your screen, and then choose the Export command. In the hierarchical menu that appears, choose Export Slideshow.”

**About the Online Resources**

As the owner of a Missing Manual, you’ve got more than just a book to read. At the Missing Manuals website, you’ll find tips, articles, and other useful info. You can also communicate with the Missing Manual team and tell us what you love (or hate) about this book. Head over to [www.missingmanuals.com](http://www.missingmanuals.com), or go directly to one of the following sections.

- **MISSING CD**
  
  This book doesn’t have a physical CD pasted inside the back cover, but you’re not missing out on anything. Go to [www.missingmanuals.com/cds](http://www.missingmanuals.com/cds) to find a list of all the shareware and websites mentioned in this book, as well as Appendix C.

- **REGISTRATION**
  
  If you register this book at oreilly.com, you’ll be eligible for special offers—like discounts on future editions. Registering takes only a few clicks. Type [http://www.oreilly.com/register](http://www.oreilly.com/register) into your browser to hop directly to the registration page.

- **FEEDBACK**
  
  Got questions? Need more info? Fancy yourself a book reviewer? On our Feedback page, you can get expert answers to questions that come to you while reading, share your thoughts on this Missing Manual, and find groups for folks who share your interest in iPhoto. To have your say, go to [www.missingmanuals.com/feedback](http://www.missingmanuals.com/feedback).

- **ERRATA**
  
  In an effort to keep this book as up to date and accurate as possible, each time we print more copies, we’ll make any confirmed corrections you’ve suggested. We also note such changes on the book’s website, so you can mark important corrections in your own copy of the book, if you like. Go to [http://bit.ly/Photos-Mac-iOS_TMM](http://bit.ly/Photos-Mac-iOS_TMM) to report an error and view existing corrections.

**The Very Basics**

You’ll find very little jargon or nerd terminology in this book. You will, however, encounter a few terms and concepts that you’ll see frequently in your Mac life. Here are the essentials:

- **Clicking.** To *click* means to point the arrow cursor at something onscreen and then—without moving the cursor at all—press and release the clicker button on the mouse or trackpad. To *double-click*, of course, means to click twice in rapid succession, again without moving the cursor. And to *drag* means to move the cursor while keeping the button continuously pressed.
When you’re told to ⌘-click something, you click while pressing the ⌘ key (it’s next to the space bar). **Shift-clicking, Option-clicking,** and **Control-clicking** work the same way—just click while pressing the corresponding key on your keyboard. (On non-U.S. Mac keyboards, the Option key may be labeled “Alt” instead, and the ⌘ key may have a Windows logo on it.)

**NOTE** New Macs come with Apple’s Magic Mouse, a mouse that looks like it has only one button, but can actually detect which side of its rounded front you’re pressing. If you’ve turned on the feature in System Preferences, then you can right-click things on the screen by clicking the right side of the mouse or by clicking with two fingers instead of one. Doing so typically produces a shortcut menu of useful commands.

All through this book, you’ll see phrases such as, “Control-click the photo.” That’s telling you that Control-clicking will do the job—but if you’ve got a two-button mouse or you’ve turned on the two-button feature of the Magic Mouse, right-clicking might be more efficient.

- **Keyboard shortcuts.** Every time you take your hand off the keyboard to move the mouse, you lose time and potentially disrupt your creative flow. That’s why many experienced Mac fans use keystroke combinations instead of menu commands wherever possible. ⌘-P opens the Print dialog box, for example, and ⌘-M minimizes the current window to the Dock.

When you see a shortcut like ⌘-Q (which quits the current program), it’s telling you to hold down the ⌘ key, and, while it’s down, type the letter Q, and then release both keys. And if you forget a keyboard shortcut, don’t panic. Just look at the menu item and you’ll see its keyboard shortcut listed to its right. (To see a list of all the keyboard shortcuts in Photos for Mac, choose Help→Keyboard Shortcuts.)

- **Gesturing.** On an iOS device, you do everything on the touchscreen instead of with a mouse and keyboard. The same is true if you use a trackpad connected to your Mac (either the built-in version you get with a laptop or the wireless, Magic Trackpad). You’ll do a lot of tapping onscreen buttons on an iOS device, though you’ll also navigate by swiping your finger across the screen (say, to move from one image to another, and so on). Dragging is also a factor, which you do by sliding your finger across the glass or trackpad in any direction—like a flick (described next), but slower and more controlled. A flick is a faster, less-controlled slide. For example, you flick vertically to scroll through lists of thumbnails, which is a lot of fun—the faster you flick, the faster you scroll up or down. Scrolling lists have a real-world sort of momentum, so they slow down after a second or two, so you can see where you wound up. Last but not least, you can zoom in on a photo by spreading—that’s when you place two fingers (usually thumb and forefinger) on the glass and spread them. The picture magically expands as though it’s made of rubber. Once you’ve zoomed in like this, you can zoom out again by putting two fingers on the glass or trackpad and pinching them together. To see a quick, animated demo of common gestures, choose ⌘→System Preferences→Mouse or Trackpad. You can also learn more about gestures by visiting https://support.apple.com/en-us/HT4721.
If you’ve mastered this much information, you have all the technical background you need to enjoy *Photos for Mac and iOS: The Missing Manual*.

**NOTE** When you Control-click (or right-click) something on your Mac, a little menu pops up. What’s listed in the menu depends on what you clicked—which is why they used to be called *contextual* menus. But these days, Apple calls them *shortcut* menus, so that’s the term this book uses.

---

**Safari® Books Online**

Safari Books Online is an on-demand digital library that lets you easily search over 7,500 technology and creative reference books and videos to find the answers you need quickly.

With a subscription, you can read any page and watch any video from our library online. Read books on your cell phone and mobile devices. Access new titles before they are available for print, and get exclusive access to manuscripts in development and post feedback for the authors. Copy and paste code samples, organize your favorites, download chapters, bookmark key sections, create notes, print out pages, and benefit from tons of other time-saving features.

O’Reilly Media has uploaded this book to the Safari Books Online service. To have full digital access to this book and others on similar topics from O’Reilly and other publishers, sign up for free at [http://safaribooksonline.com](http://safaribooksonline.com).
If you’re new to OS X or you’ve never before used iPhoto, then you can breeze through this chapter in no time flat. You’ll learn how to get Photos (if you don’t yet have it) and read an incredibly helpful overview of iCloud Photo Library (page 11), the Apple service you can use to back up and then sync your Photos library onto all of your Macs and iOS devices. This chapter also includes a wonderful strategy for managing Photos in a family situation (page 14) so that your Photos world doesn’t get out of hand. Feel free to skip everything else in this chapter and move to more exciting topics like importing your pictures and videos, which is covered in Chapter 2.

If, on the other hand, you’ve been in the Mac universe for a while and you’ve been using iPhoto or Aperture to manage your digital memories, there are some important things to consider before launching Photos. As you’ll learn starting on page 4, there’s a fair amount of preparation you need to do in order to smoothly migrate from those older programs to Photos. This chapter arms you with everything you need to know.

Getting the Photos App

You may be wondering how much Photos costs. Good news: It’s free! On both Macs and iOS devices, Photos is part of the operating system (the software that lets everything run). On Macs, the operating system is called OS X, and on iOS devices it’s called, well, iOS.

The Photos app is installed on every Mac sold since April 2015. You’ll find its circular, rainbow-colored icon in the Dock and in your Applications folder. (To open this folder, go to the Finder and press Shift-⌘-A or choose Go→Applications.)
If you bought your Mac before April 2015, you have to update your operating system to OS X 10.10.3 (a.k.a. Yosemite) or higher to get Photos. (As of this writing, the latest version of OS X Yosemite is 10.10.4. The box on page 3 helps you determine whether your Mac can run this version of OS X.)

**NOTE** Before updating your operating system, it’s a good idea to make a backup of everything on your Mac. See the box on page 285 for a great backup strategy.

To update your operating system, click the  menu at the upper left of your screen, choose App Store, and then click Updates at the top of the App Store window. You see a list of updated software patiently waiting to be installed on your machine. Locate the update named OS X Update Version 10.10.3 (or later) and click Update. Your Mac downloads the update, restarts, and installs the new version.

OS X 10.10.3 weighs in at two gigabytes, so the download process can take a while. Of course, the speed of your Internet connection plays a big role in how long this takes. You can continue working until the download is finished and your Mac restarts. When the update is complete, you see the rainbow-colored Photos icon in your Mac’s Dock and Applications folder.

**TIP** If you don’t have a high-speed Internet connection, updating your operating system can take a painfully long time and it may never fully download (say, if the connection times out). In that case, you can haul your Mac to the nearest Apple retail store, where they’re more than happy to upgrade it to the latest and greatest version for you.

Your Mac isn’t the only device that can have Photos fun—there’s a version of Photos for iOS, too. If you’re one of the billions who own an iPhone, iPad, or iPod Touch and the device is running iOS 8 or later, you’ll spot the same Photos icon on your home screen (unless you moved it, that is). To see which version of iOS your device is running, fire it up, tap Settings, and then tap General. On the screen that appears, if you tap Software Update, you see your device’s current iOS version. If your device can run iOS 8, Software Update helpfully offers to install it. You’re in good shape if you have an iPhone 4S or newer, an iPad 2 or newer, or an iPod Touch fifth generation or newer.

**Your First Foray into Photos**

If you’re on a brand-new Mac (lucky you!) or you haven’t previously used Apple’s older photo-related programs iPhoto and Aperture, then the first time you launch Photos, the program creates a new, empty file named Photos Library and plops it into your Pictures folder. (If you’re an iPhoto or Aperture veteran, jump to the next section.) A welcome screen appears that offers you a tour of your shiny new Photos app. When you click Get Started, the rather uninspiring screen shown in Figure 1-1 appears.
Welcome to Photos
To get started with Photos, do any of the following:

- Connect a camera or memory card.
- Drag pictures directly into Photos.
- Choose Import from the File menu.
- Turn on Cloud Photo Library in Preferences.

**FIGURE 1-1**
When you launch Photos for the first time, you get a sparkling clean and 100% empty library. Happily, you don’t have to remember where your library lives; Photos opens it automatically when you launch the program.

**UP TO SPEED**

**Mac Requirements for Photos**

Because Photos is included with OS X 10.10.3 (a.k.a. Yosemite), your Mac has to be able to run OS X 10.10.3 in order for you to get Photos. If your Mac is included in the following list, you’re good to go:

- iMac: Mid 2007 or newer
- MacBook: Late 2008 aluminum or early 2009 or newer
- MacBook Pro: 13-inch, Mid-2009 or newer; 15-inch, Mid/Late 2007 or newer; 17-inch, Late 2007 or newer
- MacBook Air: Late 2008 or newer
- Mac mini: Early 2009 or newer
- Mac Pro: Early 2008 or newer

Here’s how to find out which version of OS X your Mac is currently running: Click the ⌘ at the top left of your screen and choose About This Mac. The window that appears prominently lists which version you have, such as “OS X Mavericks Version 10.9.5.”

If your Mac is running OS X 10.6.8 or higher, then the update to OS X 10.10.3 is free. If you have OS X 10.6 through 10.6.7, you must first update to OS X 10.6.8 before you can install OS X 10.10.3. If, on the other hand, you’re rolling retro with OS X 10.5 or 10.4, you have to pay Apple $19.99 for a DVD that you can use to update your Mac to OS X 10.6 (Snow Leopard); only then you can update to OS X 10.10.3. You can order the OS X 10.6 installer DVD online at [http://store.apple.com](http://store.apple.com) or buy it at any Apple retail store.

To use OS X 10.10.3, your Mac needs to have at least two gigabytes of memory (RAM) and eight gigabytes of available storage space on a hard drive or SSD (solid state drive). However, those are just the minimum requirements. Photos *devours* memory and storage space at an alarming rate—blame file sizes, not the program—so the more memory and storage you have, the more smoothly and speedily Photos will run (it’s common for a Photos library to reach over 100 gigabytes in size). Your Mac’s processor speed also affects Photos’ performance, but if you have to choose, increasing your amount of memory makes a bigger impact than increasing your processor speed. That’s good news considering memory is more affordable than a new Mac!
At this point, you can skip ahead to Chapter 2 to learn about importing new content. However, it might be helpful to read the useful overview of iCloud Photo Library that starts on page 11, and you’ll find a wonderful strategy for using Photos with family members on page 14—handy if you harbor multiple Mac- and iOS-using, picture-taking people under your roof. If you’re curious about using and maintaining multiple Photos libraries, then skip to page 272.

### Migrating from iPhoto or Aperture to Photos

If you’re a longtime Mac user, you’ve probably been running iPhoto and/or Aperture for years. Alas, Apple has decided to stop updating those programs, so while it’s not urgent, your eventual best course of action is to switch over to using Photos. (Unless you relied on Aperture to edit parts of your photos, that is, in which case you’ll want to switch to Adobe Photoshop Lightroom instead.) Here’s what you should do to prepare for the transition to Photos:

**NOTE** If you never update your Mac’s operating system, the newest versions of iPhoto and Aperture will run forever. Even if you do update your Mac’s operating system regularly, you can count on using iPhoto or Aperture for several more years.

- **Update iPhoto or Aperture to the latest version, and then open your library.** To check for updates in iPhoto, open the iPhoto menu and choose “Check for Updates”; in Aperture, head to the Aperture menu instead. (The latest version of iPhoto is 9.6.1, and the latest version of Aperture is 3.6.) Once you’ve updated the program, open your library in it. By doing this, you ensure that all is well with your libraries and that they’re organized in a way Photos can understand. In other words, shiny new programs usually communicate better with the latest versions of other programs.

- **Empty your iPhoto and Aperture Trash.** Both iPhoto and Aperture are extremely careful with your pictures. When you instruct either app to delete an image, they move the file into the app’s own Trash, and that’s where it stays until you empty the app’s Trash. Even then, those images are merely moved to your Mac’s Trash. It’s only when you empty the Finder’s Trash that the image is permanently deleted from your iPhoto or Aperture library.

This protective system is brilliant, save for the fact that most people forget to empty their app-specific Trash can; they simply assume the files are long gone. And even if they remember to take that step, they often neglect to empty their Mac’s Trash. The result of upgrading a library in this state is like watching an episode of *The Walking Dead*—all those not-yet-deleted images come marching back to life in Photos.
Some of these zombie images are funneled into Photos’ Recently Deleted folder (File→Show Recently Deleted) while others appear in the program with empty, ghost-like gray thumbnails. Appendix A teaches you how to deal with this problem (page 290), but it’s easy enough to avoid in the first place. Here’s how:

- **In iPhoto**, choose iPhoto→Empty iPhoto Trash, and then click OK.
- **In Aperture**, choose Aperture→Empty Aperture Trash, and then click Delete.
- **In the Finder**, choose Finder→Empty Trash, and then click Empty Trash.
- **If you have multiple Aperture or iPhoto libraries, merge them or delete the ones you don’t need.** Page 9 and page 10, respectively, have the details.

When you’re finished with these housekeeping tasks, do a happy dance and know that you’ve done everything possible to ensure an easy transition to Photos.

When you first launch Photos, it searches for iPhoto and Aperture libraries on your internal hard drive and any external hard drives attached to your Mac. If Photos finds an existing library (or several), you see the Choose Library screen shown in Figure 1-2. (If it doesn’t find one, you see the rather Spartan welcome screen shown in Figure 1-1.)
If you pick a library from the list and click Choose Library, Photos sets about upgrading it for use in Photos. Your old library remains in its original location; Photos merely builds a new one and stores it in the same spot.

At this point, you may be getting a little panicky: “I don’t have enough hard drive space to duplicate my entire image library!” The short answer is don’t worry—Photos doesn’t duplicate your old libraries. Instead, Photos uses some seriously slick behind-the-scenes voodoo to link the contents of your old library to the new one that it creates. The box below has more info.

Now that you know your new Photos library won’t devour all your hard drive space, go ahead and pick your most important library, and then click Choose Library. When you do, Photos creates a new library for itself that contains everything from your iPhoto or Aperture library that it knows how to use. (See page 7 for details on what does and doesn’t get converted.)

In the next few sections, you’ll find important info about upgrading iPhoto and Aperture libraries for use in Photos. Understanding this transitional stuff up front will put you at ease and better equip you for life in Photos.

### FREQUENTLY ASKED QUESTION

#### Duplicate Library Magic

**I already have Aperture and iPhoto libraries on my hard drive. Am I going to run out of space if I add a Photos library, too?**

Fortunately, the answer is no. Instead of duplicating your existing iPhoto or Aperture libraries, Photos makes use of a feature called **hard links**, which are similar to the aliases that the Finder uses. When you open an iPhoto or Aperture library in Photos, each photo or video remains in its original library, and Photos simply remembers where they are and points to them.

Of course, all this happens under the hood, so it’s hard to tell what’s going on. If you view your various libraries in the Finder, it lists the file size of your new Photos library as only slightly smaller than your original libraries, which may lead you to think that the Photos library is using as much hard drive space as the old ones, but that’s not the case. The Finder is just trying to warn you that if you copy your Photos library to another drive, the duplicate will consume an enormous amount of space, because doing so forces your Mac to extract copies of all the files from your old libraries and include them in the duplicate Photos library.

This concept actually makes sense if you can wrap your brain around it. On your Mac, Photos knows where the original content is stored in your iPhoto or Aperture libraries, which are also on your Mac. If you copy the Photos library to a location that’s not on your Mac, all the hard links are lost, so the new drive is forced to store all the original content your Photos library contains.

This explains why, if you look at the amount of disk space your drive had available before you converted your iPhoto or Aperture library to Photos, the difference is nowhere near the size the Finder lists for your new Photos library. The only time your Photos library actually consumes the amount of disk space the Finder reports is when you delete your old iPhoto or Aperture library. Doing so takes a long time because your Mac has to shuffle content from those libraries into your Photos library.
iPhoto and Aperture Edits Become Permanent

If you’ve worked with iPhoto or Aperture for any length of time, you know that whenever you edit a picture or video, the program merely keeps a running list of your edit requests; your originals remain fully intact. This is what powers the “Revert to Original” command in both programs. However, when you export content from either program, the exported version is a duplicate of your original with your changes permanently applied to it.

Photos makes use of this same system when it migrates your iPhoto or Aperture libraries: It applies all the edits you made in either program and creates a new original for each file you’ve edited. Because of that, you can’t use Photos’ “Revert to Original” command to revert all the way back to the real original in iPhoto or Aperture—you can only revert to the original in Photos (which is the edited version delivered by iPhoto or Aperture).

For this reason, you may want to keep iPhoto or Aperture hanging around for a while, along with their respective libraries. That way, if you need to revert an image to its true original state, you can. To do that in iPhoto, find the image and choose File→Export. In the dialog box that opens, pick Original from the Kind menu, and then click Export. To do that in Aperture, choose File→Export→Original, set the export options, and then click Export Originals. Unfortunately, doing this strips the image of any custom metadata you’ve added to it in iPhoto or Aperture, such as keywords, face and location tagging, and star ratings (fortunately, the metadata assigned by your camera remains intact).

How Photos Handles Albums, Events, Projects, and Metadata

When you upgrade your iPhoto or Aperture library, Photos maintains all the organizational details that it knows how to use. For example:

- **iPhoto albums and events.** Photos preserves your albums, but since Photos doesn’t use Events, they migrate to a folder named iPhoto Events in Albums view. Each of your iPhoto Events becomes an album in that folder, named after the Event itself.

- **iPhoto books, cards, and calendars.** Most iPhoto projects are preserved and viewable in Photos’ Projects view. However, if a book, card, or calendar uses a theme that Photos doesn’t have, it gets converted into an album instead.

- **Aperture albums and projects.** Photos preserves any albums you made in Aperture, but all subfolders, as well as book and web projects, migrate to a folder named Aperture Projects in Albums view. (In early versions of Photos, these Aperture projects may inexplicably be placed in the iPhoto Events album, so have a look there as well.)
• **Slideshows.** Happily, slideshows from both iPhoto and Aperture remain fully intact as slideshow projects, viewable in Projects view. That said, if a slideshow made in those programs uses a theme that Photos doesn’t have, the Classic theme is substituted instead.

• **Smart albums.** If your iPhoto or Aperture library has any smart albums that rely on features not included in Photos—say, star ratings or Places tags—Photos appends “(modified)” to the end of their album names. It’s then up to you to examine those albums to see how Photos has modified their criteria. Fortunately, Photos converts star ratings and Places tags to keywords (described next) and converts smart album criteria to look for that stuff instead. However, if your original smart album uses only conditions that Photos doesn’t understand, such as “photos edited in an external editor,” then that smart album doesn’t show up in Photos at all.

• **Metadata.** Photos preserves most metadata such as keywords and titles, but Photos converts most everything else to keywords. For example, star ratings become keywords (1 Star, 2 Star, and so on), as do iPhoto Places tags (say, “Place is Maui”) and Aperture color labels (Green, Purple, and so on). Photos assigns the keyword “Flagged” to flagged images from either program and corrals them into a smart album named Flagged in Albums view. Unfortunately, custom Aperture metadata doesn’t migrate to Photos at all.

In summary, take heart that most of your iPhoto and Aperture world gets ported into Photos albums, so you’ll need to root around in Albums view to find much of your stuff. That said, slideshows stay intact in Projects view, which is really nice. Overall, the migration from iPhoto or Aperture to Photos isn’t too painful, though the inability to back out of your previous edits in those programs is a galactic drag. While a few organization tools get converted to albums and keywords, that’s better than not having those organizational goodies at all.

The truth is that switching to any program from iPhoto or Aperture, even the extremely capable Adobe Photoshop Lightroom, puts you in the exact same transitional boat...if not worse.

**Continuing to Use iPhoto or Aperture**

As mentioned earlier in this chapter, upgrading an iPhoto or Aperture library for use with Photos doesn’t move or replace it. Instead, Photos creates a duplicate library that’s a fraction of the original library’s size, as the box on page 6 explains.

The takeaway here is that if iPhoto or Aperture has a beloved feature that you can’t live without, you can keep using those programs. At least, you can for as long as you keep those libraries hanging around and your Mac’s operating system can open those programs. Unfortunately, there’s no way to know exactly how long that will be, but based on Apple’s history, you should be safe for several years.
As of this writing, if you update to the latest version of OS X 10.10.3 before you update iPhoto to the latest version of 9.6.1, iPhoto flatly refuses to launch—even if you have version 9.6. Worse yet, the iPhoto 9.6.1 update disappeared from the App Store so there’s no way to get it. This is a tragedy of epic proportions and not something that Apple is likely to fix. Fortunately, Appendix A has a few solutions.

But think carefully about the consequences before embarking on this path. If you continue to use iPhoto or Aperture, Photos won’t know about any changes you make in those programs. As far as Photos is concerned, those libraries were frozen in time the moment you converted them. Similarly, don’t expect iPhoto or Aperture to know about any changes you make in Photos—their libraries are completely separate. The best you can hope to accomplish by continuing to use iPhoto or Aperture is to export newly edited items, and then import them into Photos. If you find yourself in that situation, it’s helpful to create a smart album in iPhoto or Aperture that gathers up all the stuff you’ve changed since you told Photos to convert your iPhoto or Aperture library.

Unfortunately, if you create projects in iPhoto and Aperture after converting those libraries for Photos, you can’t export those projects individually from iPhoto or Aperture, so you’ll have to work with them in those older apps. And even if those apps could export a project, Photos can only import individual image and video files. Oh well!

**Merging iPhoto or Aperture Libraries**

While you can create multiple Photos libraries, as Chapter 10 explains, maintaining and merging them is a nightmare. So if you have multiple iPhoto or Aperture libraries—or if you created extras by accident because you have multiple user accounts on your Mac (see page 14)—it’s best to merge them before you upgrade to Photos.

Fortunately, merging Aperture libraries is easy. To merge other libraries into the currently active one, launch Aperture and then choose File→Import→Library. Navigate to where the other library lives, select it, and then click Import. In the resulting dialog box, choose whether you’d like to merge the two libraries to avoid duplicate images or whether you’d rather add all images from the imported library. Repeat this process for any additional Aperture libraries you wish to merge. When you’re finished, use Photos to upgrade the newly merged Aperture library to a new Photos library. That’s it!

Unfortunately, iPhoto doesn’t have the ability to merge libraries, so you have two different ways to proceed:

- If you have Aperture 3.3 or higher, you can use it to combine multiple iPhoto libraries into a single Aperture library that you can then upgrade to Photos. Before you begin, be sure to open each iPhoto library in the latest version of iPhoto (9.3 or higher) to ensure the iPhoto library is arranged in a way that Aperture understands.
Once you’ve done that, launch Aperture and choose File→Switch to Library→Other/New. Use the library selector to highlight one of the iPhoto libraries you’d like to merge and click Choose. Next, choose File→Import→Library, and then pick one of the other iPhoto libraries you want to merge with the first one you picked. Repeat this process for each additional iPhoto library that needs merging.

The result is an Aperture library that includes everything from the first iPhoto library you picked and from all the additional iPhoto libraries you imported. This new library exists in Apple’s unified library format, which means it can be shared between iPhoto and Aperture. You can now use Photos to upgrade the resulting merged library to a new Photos library.

- You can buy a program to merge your iPhoto libraries, which is by far the most civilized approach. One such program is the $29.95 iPhoto Library Manager from Fat Cat Software (www.fatcatsoftware.com). Using it is a straightforward affair: Simply drag your iPhoto libraries onto its window, select some options for handling duplicate images, and let it rip. You can then upgrade the resulting merged iPhoto library to a new Photos library. As a bonus, iPhoto Library Manager includes PowerPhotos, which adds some slick merging, importing, and exporting features to Photos that it doesn’t (yet) have.

### Deleting iPhoto or Aperture Libraries

Once you’ve told Photos to create a new library from your iPhoto or Aperture libraries, it won’t ever look over its digital shoulder at those libraries again. After you’ve confidently used Photos for a while, you can delete them—with the following exceptions:

- If you used iPhoto or Aperture to edit some pictures or videos, you should export those files before deleting their libraries. Afterward, you can import the exported goodies into Photos in myriad ways, as Chapter 2 explains.

- If you created a project in iPhoto or Aperture that you can’t easily duplicate in Photos, you may want to keep iPhoto or Aperture and their libraries available for future use. (You can’t export and import projects such as cards, calendars, books, or slideshows into Photos.) Just be aware that in a few years OS X may be so far advanced that iPhoto or Aperture stop working.

Honestly, since your new Photos library won’t take up much hard drive space—at least, not until you delete the old ones, as the box on page 6 explains—you may want to keep the old libraries hanging around, just to be on the safe side.

That said, when you want to send your old libraries packin’, locate them on your Mac—they’re likely in the Pictures folder—single-click a library file you want to delete, and then choose File→Move To Trash (you can also drag the file onto the trash icon in your Mac’s dock). Either way, the file disappears from its original location (in the Pictures folder or wherever it was) and cools its heels in the Trash. To delete the file from your Mac, choose Finder→Empty Trash. Your Mac will take some time to fetch all the pictures and videos that Photos needs from that library and move them to Photos’ library.
Meet the iCloud Photo Library

One of the main reasons Apple created Photos is to provide a better way to manage and access all your pictures and videos across your devices: your Macs, iOS devices, cameras, and so on. Part of Apple’s goal is to reduce the time you spend managing your digital memory collection so you’ll have more time to be creative. Apple named their solution iCloud Photo Library.

NOTE While the dynamic duo of Photos and iCloud Photo Library is more than adequate for most people, professional photographers need a more robust solution. In that case, consider using Adobe Photoshop Lightroom CC in conjunction with Lightroom Mobile instead.

The concept is brilliant: Once you turn on iCloud Photo Library, the pictures, videos and albums in your Photos library are uploaded to Apple’s iCloud servers. That content is then downloaded into the Photos app on your other devices (Macs and iOS gadgets included). Changes you make on one device are automatically synced to all your other devices. You can even view and manage your Photos library from any Internet-connected web browser. And there’s more:

• **It’s a space saver.** You can’t store all your photos and videos on all your devices; there just isn’t enough storage space. iOS devices have limited space, and Apple’s newest MacBooks have less space than they used to because they sport SSD drives, which are smokin’ fast but lack the storage capacity of their traditional hard drive forebears.

FREQUENTLY ASKED QUESTION

Syncing Part of Your library

*My Photos library is huge, but I don’t want to pay Apple to store all of it. Can’t I just sync part of it to iCloud?*

It depends on which iCloud-sharing service you go with. Apple offers three ways to share your picture and videos across multiple devices, and they each suit different purposes:

• **iCloud Photo Library** (free—$19.99/month) gives you access to all your photos and videos on all your devices.

• **iCloud Photo Sharing** (free) lets you share one or more albums of pictures and videos with other people and your other devices, be that another Mac or an iOS device.

• **My Photo Stream** (free) automatically syncs all your recent pictures and videos with all your devices (Mac and iOS gadgets).

So, to avoid paying Apple for the full volume of storage space your library requires, you’ll probably want to use the free iCloud Photo Sharing instead of iCloud Photo Library. You’ll learn far more about these sharing options in Chapter 8 (starting on page 211), though it’s important to know what your options are sooner rather than later.
iCloud Photo Library solves this storage conundrum by putting full-quality versions of all your pictures and videos on Apple’s iCloud servers. It then delivers smaller versions onto your iOS devices. When you need the full-quality version of an image—say, when you edit it—iCloud Photo Library delivers it to the device. As your device runs out of space, full-quality versions of the pictures and video you access the least are removed to make room for the new ones. As explained in the box on page 22, you can choose to use smaller versions of files on your Mac, too.

- **It manages your albums.** iCloud Photo Library manages all of the albums you make in Photos. For example, if you create or edit an album on one device, that change propagates to all your other devices. (Unfortunately, smart albums—page 69—aren’t included in the syncing party.)

- **Edit anything, anywhere.** If you add, edit, or delete a picture or video on one device, the change happens on all your other devices, too—as long as they’re connected to the Internet. That means you can start editing a photo or video on one device and finish the job on another. And because editing in Photos doesn’t mess with your originals, you can also revert to the image’s original state on any device.

- **See your pictures and videos on any computer.** You can log into your iCloud account from the web browser on any Internet-connected computer. Just go to iCloud.com and log in, and you can view and organize your entire photo and video library. How cool is that?

- **It’s a backup system.** By its very nature, iCloud Photo Library serves as an off-site backup for all your digital memories (at least, all the ones in your System Photo Library; there’s more on that in the next section). If your Mac, iPhone, or iPad gets lost or destroyed, your pictures and video are safe on Apple’s iCloud servers. This includes everything you add to your Photos library—pictures from other digital cameras (including raw files), scans of old photos and documents, videos, screen captures from your iOS devices—everything.

- **What it costs.** Everyone who registers their Mac or iOS device with Apple gets an Apple ID and five gigabytes of free storage space (Apple prompts you to register the minute you power up your new Apple device). While this is sufficient for backing up your iPhone, storing email, and saving a few Keynote files, snap-happy photographers will use up this space at warp speed. As of this writing, Apple’s monthly storage rates are 20 gigabytes for $0.99; 200 gigabytes for $3.99; 500 gigabytes for $9.99; and 1 terabyte for $19.99. These prices are per person, meaning that no one else can share the extra storage with you. In other words, each person with a Photos library is responsible for his or her own iCloud storage.

**NOTE** While other cloud-based storage services such as Dropbox, Google Drive, Microsoft OneDrive, and Amazon Cloud Drive cost less per gigabyte of storage than iCloud, they don’t offer the instant, automatic cross-device syncing of pictures and videos in your Photos library. So you pay a premium to use Apple’s system, but it greatly simplifies your Photos life.
If you pony up for more iCloud storage space but then stop paying, your devices keep the items that are already stored on them, but syncing between devices comes to a screeching halt and you no longer have a complete backup of all your stuff on the iCloud servers. (Apple doesn’t say exactly when your content is deleted, but it does happen.) The result is that your Mac becomes the only device that has full-quality pictures and videos, and your iOS devices contain a mix of full-quality and smaller versions.

Alas, iCloud Photo Library isn’t all peaches and cream. Aside from the monthly fee, uploading your library for the first time and syncing it to your iOS devices can take days. If you’re ready for that, then read on.

NOTE By the time you’re reading this, it’s possible that Apple may have come up with a way to speed up the initial upload process. One can hope!

What Gets Uploaded
Before you turn on iCloud Photo Library as explained in Chapter 2, it’s helpful to understand exactly what Apple will upload. Apple doesn’t want to shock (or extort) you the second you start using Photos, so turning on iCloud Photo Library is optional—you’re respectfully invited to do so when you create your first Photos library. Here are three key things to remember:

• Only the content of your System Photo Library is uploaded to iCloud. If you maintain multiple Photos libraries (see page 272), you can anoint only one of them your System Photo Library (page 274 explains how)—iCloud ignores all your other libraries. You can think of the System Photo Library as the master library that gets used by all iCloud services: iCloud Photo Library, iCloud Photo Sharing, and My Photo Stream (there’s more on those services in Chapter 8). It’s also the library that iTunes pulls from to deliver photos and videos to your iOS devices and your Apple TV (see the box on page 175).

If you change Photos’ normal behavior of copying your content into its library—by deselecting “Copy items to the Photos library” in Photos’ preferences (see page 28)—then any items you add thereafter won’t be uploaded to your iCloud Photo Library. This is one of the many reasons why maintaining a single Photos library per Mac user account makes managing Photos a whole lot easier.

• How it works. Since your iOS devices have limited storage space, iCloud Photo Library uses what Apple calls optimized storage, which provides each device with files that are optimized for its particular screen size. All your images are stored as thumbnails, while your most recent, favorite, and frequently accessed photos are also stored in high enough quality to be viewed clearly on that device’s screen. When you edit an image, iCloud downloads a higher quality version. The result is that the pictures that are most important to you are always available at a size optimized for the screen you’re displaying them on.
• **Security and privacy.** iCloud Photo Library encrypts your digital memories to keep them secure when transferring files to and from your Mac and iOS devices, and also while being stored on the servers. This means that snoopers can’t see your stuff. Of course, no system is 100% hacker-proof, so to be safe, don’t store any incriminating photos in your iCloud Photo Library.

In short, iCloud Photo Library is amazing. It costs a few bucks per month, but there’s nothing like the confidence and peace of mind you get from knowing that all your files are constantly backed up and that all your images are available on all your Apple devices.

### Photos for Families

So you did your family a huge favor and bought a Mac. And of course you set up four user accounts on the shiny new Mac, because your two kids are old enough to be responsible Mac users and you want them to learn how to use it. While doing so is completely logical, it causes a seriously unpleasant Photos-related consequence: Each user account you create on your Mac gets its very own Photos library.

### WORKAROUND WORKSHOP

Here’s a bit of history for you: Before OS X, the file format of graphics created and used by the Mac operating system was PICT (OS X, in contrast, creates PNG files). Back in the 1990s, Mac folks often saved their scans of printed photos in PICT format, so it’s not unusual to have some PICT files loitering in your iPhoto or Aperture libraries.

Unfortunately, Photos doesn’t understand PICT files. They tag along in the library-conversion process, but in Photos they appear as a thumbnail with a gray triangle and an exclamation point. The fix is to convert your PICT files to another format, and then reimport them into Photos.

First, you need to liberate the PICT files from Photos. In Photos, select any odd-looking PICT thumbnails you find (they’re easy to spot), and then choose File → Export → Export Unmodified Original. In the resulting pane, tell Photos how you want to name the file. Click Export, and then use the next pane to choose a location for your exported files. (If you’re exporting a slew of PICTs, it’s best to export them into a folder.)

Second, use Preview to convert the exported PICTs to PDFs. Unless you want to end up with a single PDF file of all your exported PICTs, you have to convert them one by one. To do that, launch Preview (it lives in your Dock and in the Applications folder), and then choose File → Open, navigate to where the first PICT file lives, and click Open. (If you wisely exported your PICTs into a folder, just select the folder to open all of them.) Your PICTs appear as thumbnails on Preview’s left. Select a thumbnail, choose File → “Export as PDF,” and then pick a location for the exported file. Rinse and repeat until you’ve converted all the PICT files.

After all that, you can import the exported PDF files into Photos. Chapter 2 explains how.
Let’s say your partner comes home and uploads some pictures into the currently active Photos library, which may or may not be the one associated with his user account (maybe someone else forgot to sign out when they were done computing). You, being the responsible manager of your family’s expensive DSLR camera, log into your user account on the Mac and import pictures into your Photos library. And of course your kids randomly upload photos into whatever Photos library is active at the moment.

Before long, nobody has the faintest idea where their pictures live, and you’re left with the unpleasant task of managing four completely separate Photos libraries. In a moment of desperation, you may even create a new Photos library and demand that everyone start using it instead.

**NOTE** Don’t panic if you’re already living a shared-Mac, multiple-Photos-libraries nightmare. You can skip ahead to the page 275 and learn how to merge Photos libraries and regain some sanity.

Fortunately, there’s a four-part solution that keeps everyone happy:

- **If you haven’t already, give each person their own user account on the shared Mac.** As mentioned earlier, doing so gives them each their own Photos library, email, document storage, and so on. (If you need help creating user accounts, see [https://support.apple.com/kb/PH18891](https://support.apple.com/kb/PH18891).)

- **Give each person their own Apple ID and iCloud account.** Here’s where the magic starts—by doing this, everyone gets their own email address and the ability to share their pictures and videos with the rest of your family. (Though as you learned on page 12, you can’t share iCloud storage space with other family members.) The section on Family Sharing in Chapter 8 (page 224) walks you through this step, as well as the next two processes in this list.

- **Set up iCloud Family Sharing.** This maneuver tells Apple that each person—up to six—is a member of your family and thus can share iTunes and App Store purchases among them. That way, everyone gets to use the same credit card—you get to approve kids’ purchases from your device, and you can set spending limits—and you can share a family calendar using Calendar. (You’ll learn how to set up iCloud Family Sharing on page 224).

- **Set up a shared family photo album.** When you set up Family Sharing, a shared album automatically appears in Shared view in the Photos app on all your family members’ devices. Now you can all add pictures, videos, and comments to that album, and everyone will be notified when something new is added. Members of your family can also choose to import specific items into their own libraries—say, to create a book or calendar project (Chapter 9).

This system gives everyone a little privacy, plus it’s a great long-term solution. For example, as family members get additional iOS devices or their own Macs, or they move away (yippee!), their unique Apple ID ensures that all their pictures, videos, emails, and so on migrate to the new devices. Plus they can continue to share digital proof of their adventures...even from far away.
When you buy an ebook through oreilly.com you get lifetime access to the book, and whenever possible we provide it to you in four DRM-free file formats—PDF, .epub, Kindle-compatible .mobi, and DAISY—that you can use on the devices of your choice. Our ebook files are fully searchable, and you can cut-and-paste and print them. We also alert you when we’ve updated the files with corrections and additions.

Learn more at ebooks.oreilly.com

You can also purchase O’Reilly ebooks through the iBookstore, the Android Marketplace, and Amazon.com.